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1 Introduction
1.1 Welcome
Thank you for using Data Rescue 4.

Prosoft Engineering’s Data Rescue is an easy-to-use utility to help you recover files and folders from crashed or
corrupted hard drives, floppy disks, or removable cartridges. Recovered data is saved to another medium, leaving the
original disk untouched.

1.2 Latest Version of the Software
The downloads section on our web site https://prosofteng.com/downloads/ always has the latest version of this
software. If you already have a copy of Data Rescue installed and an active internet connection, Data Rescue will
inform you when an update is available when launching the program. If you do not have the latest version of Data
Rescue, download it from the URL above.

1.3 Contact Prosoft Engineering
Our technical support is free and can be accessed by email or phone. Please have the version number ready before
calling:

Website: https://prosofteng.com/contactus/
Phone: 1-877-477-6763

1.4 System Requirements
There are two ways to run Data Rescue. You may run it from BootWell or you may run it from your desktop as a normal
application, depending on your circumstances.

Application Requirements:

Mac OS X 10.8 or later.
A second drive to recover to*.

* This drive must have free space for recovered files, plus 2% the size of the drive or volume to be scanned.

1.5 General Usage
Data Rescue was designed to be used in a wide range of situations. Specifically, Data Rescue can handle:

Any type of media which appears as a disk device (hard disk, CF camera cards, etc.)
Volumes which can’t be mounted, even if the driver is damaged
Disks with a damaged partition map
SCSI, IDE (also called ATA or PATA drives), SATA, FireWire and USB drives
HFS and HFS+ (“Mac OS Extended”) formatted partitions
Limited support for non-HFS/HFS+ file systems (FAT32, NTFS, etc.)
Large volumes (1 TB and larger)
Password-protected volumes (if data is not scrambled/encrypted)
Non-Roman-script (e.g Japanese) file names

Be aware that you need disk space on another device for Data Rescue’s temporary working space, and to recover your
data. This must be a separate drive from the drive you are trying to recover from, in order to avoid altering that drive.
Data Rescue offers the most extensive, safe recovery of your important data. Because your corrupt drive is not stable,
Data Rescue will not allow you to try and save files to the same drive, nor will Data Rescue try and “repair” that corrupt
drive (doing so could actually cause more corruption and data loss).

1.6 Basic Recovery Tips
This section will provide you basic tips to help you improve your chances of recovering your data before using Data
Rescue.

Prevent writing to the hard drive.  Once you are aware you are missing data, immediately quit all programs you are
using and turn off the computer. Further writing to the hard drive may overwrite data you are trying to recover. This

https://prosofteng.com/downloads/
https://prosofteng.com/contactus/
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includes creating new documents, browsing the Internet, or running disk repair utilities to attempt to fix the drive.

Evaluate the situation. Every data recovery scenario is different and may require different approaches to recover the
data. Read “Installing and Starting Data Rescue” in chapter 3 to determine the best method for recovering data in your
situation.

A second hard drive with adequate space is necessary to recover data and host Data Rescue’s storage
location. If you have a second internal hard drive in your computer or an external USB/FireWire hard drive attached to
your computer, you may use it for this purpose. Make sure you have enough free space to hold the data you wish to
recover, plus an additional amount of 2% the size of the volume or disk being scanned. For example, if you need to
recover 25GB of data from the bad hard drive, you will need at least 25GB for the recovered files and 0.5GB of free
space for the storage location. In certain situations, recovered files will require more space than they occupied on the
original drive.

Consider acquiring a replacement hard drive.  If you do not have a second hard drive to recover to, you may want to
acquire a new hard drive. If your hard drive is physically failing, a replacement hard drive will be necessary to maintain
your data. Not only will the new hard drive help you with your recovery immediately, but the new hard drive may also
be used as a backup hard drive in the future when your recovery is complete.

1.7 Drives With Suspected Hardware Problems
Even though Data Rescue exercises caution to never damage your drive’s data by writing to it, there are certain types
of drive hardware failures which due to their nature can cause additional damage to the media and data just by
continuing to use the drive.

One example of this kind of damage is a crashed disk head, which could potentially cause additional media scratching
and data loss with continued use. One clue to this type of damage may be unusual mechanical sounds emanating from
the drive. If you suspect this type of damage, and the data on the disk is extremely critical, you may wish to send your
drive to a professional drive recovery service with clean-room facilities.

The cost of professional recovery services can run into the thousands of dollars. If you suspect hardware damage, but
need to avoid the expense of the professional services, you can minimize the chances of further damage to your drive
by first cloning it to a spare drive, then do the recovery on the clone.

1.7.1 If your drive is not visible in Data Rescue

If you don’t see your hard drive displayed in Data Rescue’s list of drives, please review the checklist below:

For external drives:

Power cord (if required) is connected to a working outlet
Data cable (USB, FireWire, etc.) is connected to a working port
Data cable and power cord are known to be in working condition
Status lights (if any) are active

For internal drives:

Data cable (SATA, etc.) is connected to a working internal slot/port
Power cable is connected to a working power supply

If your hard drive is still not visible in Data Rescue or is making clicking noises, there may be a hardware problem
affecting the drive from being recognized by the computer. Prosoft Engineering’s The Data Rescue Center may be able
to help you recover data from your hard drive.

For Software Technical Support:

Website: https://prosofteng.com
Phone: 1-877-477-6763

To Inquire about Data Recovery Services:

Website: http://TheDataRescueCenter.com
Phone: 1-877-501-4949

Table of Contents
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2 Installing and Starting Data Rescue
This chapter provides basic instructions on installing and starting Data Rescue. If you are using Data Rescue for the
first time, you should read this chapter in detail.

2.1 Install/Uninstall Data Rescue
If you have the Data Rescue BootWell drive, it is not necessary to install Data Rescue and you may boot from the Data
Rescue BootWell to run the program.

If you plan on installing Data Rescue to a disk, you should NOT install it on the disk you are trying to recover files from.
If you are trying to recover files from a disk that you normally use as a boot drive, you will need to either boot from the
Data Rescue BootWell, or else set up a different drive to boot from and install Data Rescue on that drive. You may
install Data Rescue on your recover disk or storage location disk and run it from there. It does not necessarily have to
be installed on or run from your boot disk.

The following are instructions for users with a downloaded version of Data Rescue.

To install Data Rescue:

1. From the location to which you downloaded Data Rescue, double-click on the Data Rescue image
(.dmg) file to mount it on your computer.

2. Drag the contents of the Data Rescue drive (the mounted disk image) to your Applications folder or
elsewhere, if desired.

Caution: do not install or copy Data Rescue on (or make any other changes to) a volume from which
you want to recover files. Doing so may reduce the chances of recovering files from that volume.

To uninstall Data Rescue:

1. Drag Data Rescue into the Trash.

For users with the bootable BootWell drive, please see the BootWell section for more information.

2.2 Before you start Data Rescue
Data Rescue requires access to a safe location for its scan files and to store your recovered files. In the interests of
performance, your best option is to plug in an external, freshly formatted hard drive, or to use a separate internal drive.
Make sure the capacity of this drive is great enough to contain all the files you plan to recover from your damaged hard
drive, plus space for Data Rescue’s temporary storage files.

It is not recommended to try and use a slow drive such as a network drive, USB 1.0 drive, etc. for temporary storage
because doing so will have a severe performance impact on Data Rescue.

2.2.1 Note on Data Rescue’s Temporary Storage Location

What is the Temporary Storage Location?

The temporary storage location is a drive, or a folder on a drive, that is used during a scan to store persistent
information found during a scan.

Choosing a Location

Data Rescue will automatically choose the startup drive as the default location, unless there is not enough free space
remaining. If running from BootWell, Data Rescue will automatically choose a location on the BootWell drive for you.

While selecting a scan task, Data Rescue will determine if the current storage location is valid. If it is not valid, you will
be required to choose a new location. Select Change in the tasks window when prompted and you will be taken to the
Temporary Storage Location window. Here you will be presented with a list of all potential locations.
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Valid and Invalid Locations

Not all locations will be valid choices. A potential location must:

be located on a separate physical drive from the drive selected for scanning
contain a valid Mac OS Extended file system (HFS+) with write-access (see below)
have enough free space to store information about the drive selected for scanning. This value is estimated to be
2% of the selected drive’s capacity.

Erasing a non-Mac Location

If a location selected is not a valid Mac file system, Data Rescue can erase it so that it can be used as a storage
location if it’s identified as “erase required”. In this situation you can select the location and click Choose. A Erase
window will be displayed to confirm the operation. Once erased, you can go back and re-select the location once again.
Please note, erasing a volume will destroy all file data on it. This feature is most often used for when a new drive is
purchased from a retail store and is not properly formatted for use with a Mac.

2.3 Starting Data Rescue
Launch the application by double-clicking the Data Rescue icon in the Data Rescue folder. If Data Rescue has not
been run before, an authentication window will be displayed. This prompt authorizes Data Rescue to access your
drives with special privileges.

Enter the username and password of an Administrative user. If you are the only user of your system, then you are most
likely the administrative user, and you can use your own name and password. If you do not have an administration
password for your computer, please contact your system administrator to log in for you.

2.3.1 Selecting the Home Folder from BootWell

The Home Folder is the location used to store preferences, registration, FileIQ settings and more.

When Data Rescue is used from the startup disk as a normal application, it will use the user’s home folder (e.g.
/Users/you/). However this location is not available when booted from BootWell. Instead BootWell will do its best to use
its own special location, but if this location is not found, you will be prompted to choose a location.

Generally, you should select a folder on a separate physical drive from the drive that you want to scan. If you use the
drive you want to scan you could potentially damage the possibility of a full recovery.

Data Rescue will provide you with a list of potential locations for the Home Folder. If a folder contains a name below it,
then this means that that folder has a valid registration file and is most likely the home folder you should choose.

If you are unsure of what to use, choose Skip and Data Rescue will use a temporary location that will be erased once
the computer restarts. This temporary location is stored in memory and will not affect any attached hard drives.

2.4 Activation
To use Data Rescue it must be activated with a serial number. To obtain a serial number, please visit
https://prosofteng.com/datarescue4/.

2.4.1 Where is my serial number?

If you purchased Data Rescue from Prosoft’s website, your serial number will be listed in the “Order Confirmation”
email sent to you. If you have lost or deleted the email, please contact Prosoft.

If you purchased Data Rescue through a reseller, your serial number will be on the physical package itself or the
invoice. Prosoft does not have your serial number or information to look it up. Please contact the reseller for more
information.

Table of Contents
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3 Using Data Rescue
3.1 Welcome to Data Rescue
After Data Rescue starts up, the Welcome screen will be shown.

When running from a normal Mac desktop environment, a BootWell button will be shown. It will be one of the two:

Create BootWell Drive
See BootWell for more information.

Restart into BootWell Drive
If Data Rescue is running from a BootWell drive, this option will be available. See BootWell for more
information.

For normal operation, the buttons shown will be:

Start Recovering Files
Choose this option if you want to begin scanning a drive. This will be the case for the majority of users who
haven’t used Data Rescue before.

Resume Recovering Files
This will resume the last recovery session. If you have suspended a previous scan, you can use this option to
continue scanning where you last left off. Make sure you have the original drive that was being scanned
connected to your computer. If you have a completed scan, this will bring you to the scan results where you can
locate files for recovery.

When expert mode is enabled, the buttons will be:

Start New Scan
This behaves the same as Start Recovering Files.

Resume Suspended Scan
This behaves like Resume Recovering Files when you have one or more suspended scans.

Browse Completed Scans
This behaves like Resume Recovering Files when you have one or more completed scans.

3.2 Step 1: Selecting a Drive or Volume to Scan
The first step is to select the hard drive or volume that is missing the files. This step shows a list of all the disk drives
and volumes that Data Rescue can see on the system.

Data Rescue shows a two-level list of all the disk drives and volumes. The first level shows the hardware names of the
whole drive, which may include the make and/or model of the hard drive. This will scan the entire hard drive with any
partitions.

The second level shows the volumes that belong to the hard drive. In most cases, you will want to select the volume
first if it is available. Volumes that are not mounted will be listed with a gray (dimmed) font. Although this may indicate
volume corruption, the volume may be selected to be scanned.

The following lists will help you determine what to select based on your situation.

Select the hard drive name if:

The volume is not listed
The hard drive was reformatted or repartitioned
No data is found by a Quick Scan on the volume

Select the volume name if:



You are looking for deleted files
The volume failed to mount, but shows in the list

3.2.1 Add File to Scan

Add File to Scan allows a file to be added to the Source list and enables the file to be scanned for any additional data
that is a part of the file. This feature is especially helpful to help recover from damaged disk images that fail to mount.

To add a file to scan:

1. In the Source step, select File > Add File to Scan .
2. Browse for and select the file you want to scan.
3. Click on Open to add the file to the Source list.

Once the file has been added to the Source list, you may proceed with the standard steps to scan the file.

3.3 Step 2: Choose a Task
The second step is to select the task to perform on the volume or hard drive. This step will let you choose to scan or
clone your volume or hard drive.

To choose a task:

1. Click on the icon for the task you would like to perform.
2. Click on the Start button. Wait for the Scan process to complete.

Data Rescue provides a variety of functions to help search for the data on your hard drive. Each scan method is
designed to help recover different scenarios. See the tasks section for more information.

3.3.1 Canceling a Scan

After clicking the Start button, Data Rescue will begin its scan process on the hard drive. You may interrupt the scan
process at any time by pressing Cancel. A prompt will confirm if you want to cancel the process. To cancel the scan in
progress, click on the Cancel button in the prompt. To close the prompt and return to the scan, click on the Continue
button. If you are using a Deep Scan or Deleted Files Scan, the confirmation prompt will have two additional choices
for Suspend and End Early .

Selecting the Suspend option will save your current progress, allowing you to continue the scan where you left off later
on, even if you have quit Data Rescue or rebooted your system in the meantime. This is a helpful option if you have to
temporarily stop the scan and continue at a later time. Suspended scans can be reloaded later through the Manage
Scans selection in the File menu. See the Manage Scans section for more information about loading suspended
scans.

Selecting the End Early  option will force Data Rescue to end its current scan and provide results up to that point of the
scan. This is a helpful option if you are having difficulties scanning a hard drive due to bad blocks or slow reads.
Please note that ending the scan early will end only the first phase of Data Rescue’s scan process, and will still
progress through the next two phases of the scan process to catalog the results. The results from the ended scan may
take up to an hour to process. Allow adequate time for the results to be processed.

3.4 Step 3: Find and Mark Files
The third step is to mark the files and folders to be recovered. Marking a folder will automatically mark all the files and
folders contained within the folder.

Data Rescue will organize files into two different folders: Found Files and Reconstructed Files. The files found by Data
Rescue will be organized depending on the scan method you use.

Found Files will be listed in the results window when using a Quick Scan or Deep Scan. Found Files displays any files
from any file systems it detects, listing original directory structures and file names. You will want to look through the
Found Files results if you are recovering from a hard drive that has failed to boot to the operating system or if your
external hard drive is failing to mount.

Reconstructed Files will be listed in the results window when using a Deep Scan or Deleted Files Scan. The
Reconstructed Files results will organize any found files by category and file type. These results will NOT have their
original directory structure and will usually not have their original file names since they are found by file patterns. You
will want to look through the Reconstructed Files results if you are recovering from a hard drive that was accidentally



reformatted or had files that were accidentally deleted.

We do not generally recommend selecting and recovering all of the Found and Reconstructed files simultaneously,
especially from a Deep Scan. It is generally better to spend a little time to select and recover just the files and folders
you want. For example, Deep Scans typically contain huge amounts of Mac OS files and folders that will not be useful
when recovered, and will just increase the time and space needed for the recovery. You can browse and/or use the
search feature to help locate files you are interested in.

In addition, if you intend to recover many files under Found Files, we recommend that you start by recovering a few
important files first, then verify that the files open properly before recovering the rest of the listed files.

3.4.1 Previewing Files

Data Rescue allows you to preview major file types before recovering the files. This will help determine whether the
files can be recovered properly before being transferred onto another hard drive. Major file types such as .doc, .pdf,
.mp3, and .jpg can be previewed through Data Rescue.

To preview files within Data Rescue:

1. Click on a file’s name within the list to highlight it.
2. Click on the Preview button or press the space bar on the keyboard to view a thumbnail of the image or

an overview of the document.

As a convenience to the user, double-clicking on a file in the Scan Results window will cause the file to be temporarily
recovered and the operating system will open the file with the appropriate application. For example, double-clicking on
a .mov movie file will open the default media player application, typically QuickTime. This double-click preview feature
is only available while booted directly into the Desktop environment.

To preview files within their default application (while booted from the operating system):

1. Double-click on the file you want to preview.

3.4.2 Searching the Scan Results

The search feature will allow you to quickly filter your results and find your most important files. If you are looking for a
specific file, you may use the Search Field in the Scan Results window or click on the Edit menu and select Find.

The Search Field in the Scan Results window can be used to quickly filter the results for specific filenames or
extensions. The Scan Results window will be updated with any files that match the extension or word within the
filename. Highlighting a file from the list will display the path to the file on the bottom half of the window. Please note
the Search feature does NOT look within the contents of the files for keywords.

To use the Search Field:

1. Click in the Search Field and type in a file name or extension.
2. Press the Return key on the keyboard, or click on the Search button. Allow adequate time for the results

to filter and update the list.

The Find feature in the Edit menu allows you to search for specific criteria of a file, including file name, date created,
and file size. This allows you to filter out a range of files if you remember the date created or file size.

To use Find feature:

1. Click on the Edit drop down menu and select Find.
2. Optionally, check Search selected folder only  to only search the selected folder.
3. Select the parameters for the file you are trying to find and click on Search.

After viewing the Search results, you may return to the complete Scan Results by clicking on the View drop down
menu, and selecting Scan Results. Any files marked for recovery in the Search results will remain marked for recovery
when returning to the Scan Results.
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3.4.3 Recovering Files

While previewing the files, you may begin marking any files to recover. You may choose to recover each file
individually or in groups by marking multiple files and pressing the Recover button, or dragging and dropping files into
a Finder window to recover them to the destination hard drive.

After completing a scan and before recovering a large number of files, it is highly recommended to first try and recover
only a few of your important files to make sure they contain good data. There are some situations where there can be
uncertainty about the proper Allocation Block Layout choice section for more information about Allocation Block
Layouts).

Specific files can be marked for recovery by using the checkboxes within the scan results. This allows you to choose
multiple files throughout the scan results to be recovered as one process. If you would like to recover all the possible
results from your hard drive, you can mark the root selections Found Files and Reconstructed Files, however it is
generally best to select specific files and folders you want to recover to save time and hard drive space.

To recover files using the checkboxes:

1. Click on the checkboxes to mark any files you are interested in recovering.
2. Click on the Recover button.
3. Select the destination for your files to be transferred to and click on Open. Allow adequate time for the

files to be transferred onto the destination.

The “drag and drop” recovery process is the quickest way to move a file or folder to the destination hard drive if you are
booted from your operating system. However, this method of recovery is not available while booted from the DVD since
the operating system’s Finder windows are not available to drag to a destination.

To recover files using the drag and drop method:

1. Highlight the file or folder you want to recover.
2. Click and drag the highlighted file or folder from the Scan Results list onto the destination hard drive or

folder on Apple’s Finder. Allow adequate time for the files to be transferred onto the destination.

Table of Contents
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4 BootWell™
BootWell™ is a feature that allows Data Rescue to create a bootable disk to recover files from your main drive (also
known as your startup disk).

If your purchase of Data Rescue included a BootWell drive, follow the instructions below to boot into the drive.

To boot from a Data Rescue BootWell drive :

1. Insert the BootWell drive
2. Turn on, or restart the computer.
3. Immediately press and hold the Option key.
4. Select “Prepare Data Rescue” when it appears.

If you do not have a BootWell drive, you can create one yourself.

Before starting, you must have:

A drive that is 4 GB in size or greater. USB is preferred.
A working internet connection

Warning: the drive selected for BootWell will be erased!

To create a BootWell drive:

1. Go to File > Create BootWell Drive
2. Select a drive to use
3. Choose Start and confirm the operation.

After the BootWell drive has been created, you may now boot into that drive to begin using Data Rescue using the
instructions above.

Table of Contents
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5 Tasks
5.1 Quick Scan
Select the Quick Scan if:

A drive’s operating system fails to boot.
An external drive fails to mount.

The Quick Scan is the fastest method that detects existing directory structures even if your volume does not mount.
This scan will detect files with their original folder hierarchies and file names. It is recommended to try this scan method
first if your volume is detected on the hard drive.

A Quick Scan can only be used on a volume. If you have selected the hard drive to be scanned, the Quick Scan will
attempt to search for the first available volume on the hard drive, then rebuild the directory structure for that volume.

The Quick Scan typically takes a few minutes to complete, but may take up to a few hours to retrieve the results in
more severe cases. Bad blocks on the hard drive may slow down the scan process, but will immediately speed up
once it has overcome those bad blocks.

5.2 Deep Scan
Select the Deep Scan if:

No volumes are detected on the hard drive.
A hard drive was reformatted.
The Quick Scan did not provide expected results.

The Deep Scan is a comprehensive scan method that provides the most results possible. The Deep Scan is a two part
scan method: 1) detects existing directory structures on the hard drive, 2) scan the whole hard drive for any file
patterns to rebuild the raw data of any recognized files.

As the first part of the scan, Deep Scan will detect any existing directory structures like the Quick Scan, but can detect
multiple directory structures while scanning hard drive with more than one volume. This will provide you with results
from each found volume, with their original directory structures and file names.

The second part of the Deep Scan searches the entire hard drive for any files based on file patterns. Data Rescue
detects over 150 major file types based on the files’ raw data. These found files will not have their original directory
structure or filenames since Data Rescue is rebuilding the files based on their file design. Instead, these results will be
provided with generic filenames and organized by category in the Reconstructed Files folder.

The Deep Scan usually takes up to three minutes per gigabyte. With large capacity hard drives, it may require several
hours to complete a scan. Physical issues such as bad blocks on the hard drive may slow down the scan process even
longer, but the scan will immediately speed up once it has overcome the bad blocks. Allow adequate time for the scan
to finish.

5.3 Deleted Files Scan
Select the Deleted Files Scan if:

Files were deleted through the operating system.
Files were deleted by another program.
A fresh installation of an operating system overwrote an existing hard drive

The Deleted Files Scan is a specific scan method that searches only the free space of a volume for any files based on
file patterns. Scanning only the free space allows the Deleted Files Scan to specifically detect any files that were
deleted.

Once files are deleted through the Mac Operating System, there is no more reference to their original directory
structure, filename, or date created/modified. Data Rescue will not be able to detect the original information of that file
in the directory structure. Instead, Data Rescue will rebuild any files that it detects based on its file patterns. The
results of the Deleted Files Scan will be provided with generic filenames and organized by category in the
Reconstructed Files folder.

The Deleted Files Scan usually takes up to three minutes per gigabyte of free space available on the volume. This
makes the Deleted Files Scan faster than a Deep Scan since it is not scanning any known used space on the volume.
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5.4 Clone
Select the Clone feature if:

The hard drive appears to be having some hardware problems
Quick or Deep Scans are stating an excessive amount of time to scan
You need an identical copy of the hard drive

The purpose of the Data Rescue cloning function is to copy a drive or volume to another drive or volume, so that the
copy may be scanned, reducing the wear-and-tear on the original hard drive. This will free the hard drive from use
while preserving the data that was on it for later scanning. Cloning is normally not required in order to scan and recover
files with Data Rescue. The goal is to transfer all the data from the source to the destination, making a perfect one-to-
one copy where it is possible. In some cases, due to disk errors on the source, copying can be hindered to the point
where getting a perfect 100% is not possible because of the huge slowdown in read rate caused by errors; then the
goal becomes transferring as much of the source data to the destination as possible within a certain time period.

To use the Clone feature, a spare hard drive is needed with the same or larger capacity than the original hard drive.
The Clone feature makes a single pass copy of your hard drive onto another hard drive or into a disk image. Please
note the cloned hard drive will be in the same logical state as the original hard drive. This means if the original hard
drive is failing to mount or boot, the cloned hard drive will have the same failure to mount or boot. The purpose of the
clone is to help overcome any slow reads or possible hardware failures that exist on the original hard drive.

If the original hard drive appears to have hardware problems, it is highly recommended to clone the hard drive first to
reduce the use of the source drive while it is still operating. Once the original hard drive is cloned, you may put the
original hard drive away for safekeeping and perform the recovery options on the cloned hard drive.

To Clone a hard drive:

1. Select the device level of the hard drive in Step 1.
2. Select the Clone task in Step 2.
3. Select the Clone Target where the hard drive will be cloned to and click on Start Clone. Wait for the

clone process to complete.

Cloning the device level will copy the entire hard drive’s partition map onto the other hard drive. If there are multiple
partitions on the hard drive, the partitions will be cloned onto the destination as well. You may select and clone
volumes rather than the whole hard drive; however, this is only recommended if you are instructed by Prosoft technical
support or you have knowledge and experience about disk partitions and volumes.

Warning: The Clone process will overwrite the contents of the Clone Target. Ensure you have a backup
of the contents of the Clone Target hard drive, or use an empty hard drive. Be extremely careful to
choose the target so that you don't write to the wrong drive or volume.

To Clone to a disk image:

1. Select the device level of the hard drive in Step 1.
2. Select the Clone task in Step 2 and click on Continue.
3. Select New Disk Image as the Clone Target.
4. A prompt will appear to title the saved disk image. Give a title to the disk image and select the

destination for the disk image file and click Save.
5. Click on Start Clone. Allow adequate time for the clone process to complete.

Cloning to a disk image will allow you to save the entire contents of a hard drive into a single file. This is a good option
if you have available hard drive space, but do not want to erase the contents of another hard drive. The disk image can
be opened later to help simulate the original hard drive and complete a scan for recovering files.
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6 FileIQ
FileIQ is accessible under the View menu.

Select the FileIQ feature if:

A file type you are searching for is not found
You have a special file type that is not supported by Data Rescue
You want to check if a file type is supported

If Data Rescue does not recognize the file type you are trying to recover, FileIQ will help Data Rescue to learn new file
types. Data Rescue will analyze any good working file samples and detect any file patterns to help find missing files of
that file type. FileIQ will work for many, but not all types of files. However, Data Rescue will tell you if your sample files
are likely to work or not, and there is nothing to lose by trying.

To add a new file type into Data Rescue:

1. Click on FileIQ.
2. Click on the + icon to add file samples.
3. Choose any at least 5 files of the same file type.
4. Click on Open to add the files into the list.
5. Click on Save.

To utilize FileIQ, Data Rescue needs to analyze good working files of the same file type that is missing. These may be
older files that you have previously created with your program. You will usually need to reference at least 5 files of the
same filetype to properly create a file module; however in some cases, as few as two files may work. In general, the
more file samples provided into FileIQ, the more accurate the created file module will be. If you do not have sample
files available, you may consider creating some files of the same file type with the program used to make the files.
However, ensure these files are not saved to the hard drive missing the data.

Click on the + icon or drag the sample files into the Add New Type window. A spinning progress wheel will appear
below the list to indicate the files are being analyzed. If no additional information is reported back in Data Rescue, you
may click on Save to add the file module to the Learned Types List.

6.1 FileIQ Advanced Options
Show advanced options  displays some additional parameters that you may use to further define the file module.

The Details tab includes some fields to describe the file type, how the file names will be generated, and which folder
they will appear in. Data Rescue will automatically fill in most of the fields when sample files are listed in FileIQ. Data
Rescue will fill in the Template File name, Extension, Folder Name, and Max File Size based on the sample files’ data.
The fields will define the following attributes for the file module:

Name is an optional field that you may fill in to describe the File module. This will be displayed in the
Preference’s Scan Engine Tab.
Template File Name is the generic name that will be provided to any found files.
Extension is the file type determined by the file samples.
Folder Name is the location where the found files will be displayed in the scan results list.
Max File Size limits the size of the data captured for the file. Ideally this should be large enough that you are
sure all files of this type are smaller than this limit. If in doubt, you may make this value larger because files
larger than this number will either not be found or will be truncated when recovered. If you do not specify a
value for Max File Size, Data Rescue will choose a value that is about 10 times larger than the largest file
sample you added.

The Quality tab will display two scales to detect the file patterns reliability for the file module. Diversity relates to how
many samples there are and how many samples have different lengths. The Match Strength displays the number of
similar bits found between the separate files. Data Rescue will update these bars each time a sample file is added or
removed. The larger the values are for both Diversity and Match Strength, the more reliable the file module will be for
Data Rescue to detect the files.

If you’re having trouble getting an acceptable set of samples, it is best to remove all the sample files and add them one
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at a time. You can improve the Diversity by adding another sample file. If the Match Strength suddenly decreases
when you add another sample file, it may be because that file is actually different in format than the samples you
already added. In that case, remove that file and adding a different one. Please remember that certain types of files do
not have distinctive starting patterns, and therefore will not be recoverable by example at all, not matter what
combination of samples you give. If you find that you cannot get both Diversity and Match Strength above half-way,
see the next section on troubleshooting.

The Pattern tab allows you to modify the matching algorithm. The Matching drop down menu instructs Data Rescue
how selective to be in matching start patterns for the file type. The default selection for Normal will give a basic
comparison of the bits to determine the file pattern. If your scan returns too many files that are not similar to the
filetype, you may change the Matching selection to Tight. This will make Data Rescue compare more bits in the file
pattern to potentially detect the files more accurately and reduce the amount of results provided. If your scan returns
too few files, you may change the Matching selection to Loose to compare less bits in the file pattern and provide more
scan results.

If Data Rescue determines that the sample files have a usable and consistent end pattern, it will use enable the Use
End Pattern option. Using an end pattern should result in recovered files that have the correct length, instead of
potentially adding incorrect data. However, enabling the Use End Pattern option may reduce the scan performance
considerably and may take longer to complete the scan. If you uncheck the Use End Pattern option, the end pattern
will not be used for the scan.

Data Rescue currently does not support editing previously saved definitions. To change the Matching selection, you
will have to recreate the FileIQ definition and save the different matching selected.

Once you click Save, new file types will immediately be installed in Data Rescue to allow you to search for their
respective files.

6.2 FileIQ Troubleshooting
After dragging the sample files, you may be provided with a few different outcomes. This section discusses some
cases that may occur while trying to generate a file module.

The file samples may be recoverable by an existing module. If a file module is listed in the “Recoverable by Existing
Module” field, then it may not be necessary to create a file module. This means the file samples you have provided are
similar to another file module that Data Rescue already detects. The results you are provided by a scan may already
detect your files, but you may need to rename the extension to open the files properly by your program. As an
alternative, you may choose to save the file module to replace the existing module and a new scan of the hard drive
will detect your files properly. A common example of this are certain camera RAW images that are sometimes found as
TIFF images instead.

FileIQ may not detect a suitable starting pattern for the sample files. If different programs create the same kind of file,
it’s possible the files with the same extension may not have the same starting pattern, and therefore won’t produce a
usable result. For example, Quark and FreeHand programs both create EPS files, and if you took samples from both
programs to create a file module, FileIQ may report an issue because the programs create different formats for the
files. You may consider replacing some of the sample files with other files of the same type. For best results, use file
samples that are created from the same program, and preferably the program that produced the files you are looking
for.

There are cases in which FileIQ cannot create a file module. Some reasons a file module may not be created include:

The files are packaged file types.  These are files that appear as a single file, but are actually folders with
more data inside them. Since packaged files are made of multiple files, there is no method to reconstruct the file
as a whole. Common examples of packaged files are Application bundles.
Inconsistent file patterns.  These are files that do not have common file patterns that can be detected between
the files due to different internal formats or raw data throughout the file. An example of this may include
database files.
Repetitive file patterns.  These are files that have a common file pattern that repeats multiple times throughout
the file that a correct end of file cannot be determined. An example of this is a video file that has the same file
pattern repeating every frame. This may result in a large number of single frame video files, but not a complete
video.
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7 Manage Scans
Data Rescue keeps the different scans that have taken place in its temporary storage location. The Manage Scans
feature allows you to continue a previously suspended scan or delete previous scans which are no longer needed. By
keeping previous scan results, Data Rescue allows you to return to the earlier scan results to recover additional files.

Scans that are stored are in a form that allows quick access to them. However, they can take up considerable space.
The Manage Scans allows you to save one or more scans in a compressed .drscan file, after which you could delete
those scans. Later if you want to restore any of those scans, you can load them from the previously saved .drscan file.
This also works for suspended scans.

7.1 Resuming Suspending Scans
Suspended scans may be resumed from the Manage Scans window. Ensure the same hard drive on which the scan
was started is connected before resuming the scan.

To resume a suspended scan:

1. Click on File and select Manage Scans.
2. Highlight the suspended scan.
3. Click Resume.

The previous scan will begin immediately and continue where the scan was suspended.

7.2 Saving Scans
Saving scans allows a user to save the results of a scan into a .drscan file to be reloaded at another time. This feature
is primarily useful to archive scan results for access at a later time, or on the same computer setup, without taking up
space in the meantime. It could also be used when a scan needs to be continued on another machine. For example,
consider that an external hard drive has failed and a scan was started on a MacBook, but the user decided they
needed that MacBook for another purpose. The user may save the the scan file onto a separate device (such as a USB
flash drive), connect the external hard drive to a different Mac computer, and import their scan with Data Rescue from
that machine.

There are restrictions when resuming or accessing a saved scan. The scan must be accessed by the same basic type
of Mac (PPC or Intel based), running the same major Mac OS version, and either the same or a compatible version of
Data Rescue.

To save a .drscan file:

1. Click on File and select Manage Scans.
2. Highlight the scan(s) you want to save.
3. Click on the gear wheel button on the bottom left corner and select Export.
4. Select a destination, title the file, and click on Save.

Please note that more than one scan can be saved, allowing you to archive multiple scan results into one .drscan file.
The file must be saved on a separate device, not on the hard drive or volume that is missing the files.

7.3 Importing Scans
As described in the previous section, a scan can be imported from a .drscan file.

To import a .drscan file:

1. Click on File and select Manage Scans.
2. Click on the Option (gearwheel) button on the bottom left corner and select Import.
3. Select the saved .drscan file and click on Open.
4. A prompt will appear to “Choose Scans to Import”. Highlight the scans you want to load and click on

Import.
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The imported scans will be listed within the Manage Scans window. Once imported, you may select a suspended scan
to continue, or go to the View menu and select Scan Results to view any completed scans.

7.4 Deleting Previous Scans
Data Rescue archives all scans that it has completed. These scans may take up several hundred megabytes to
gigabytes of space. After a scan is complete and the data has been recovered from the drive in question, you may
delete the previous scan from Data Rescue to reclaim the space on the hard drive. Deleting the scan is recommended
only when the recovery process is completed. Once the scan results are deleted, the scan will need to be started from
the beginning once again if further results were needed.

To delete a previous scan:

1. Click on File and select Manage Scans.
2. Highlight the scan(s) you want to delete.
3. Click on the Option (gearwheel) button on the bottom left corner and select Delete.
4. A prompt will appear to confirm to delete the scan. Click on Delete to remove the scan.

7.5 Reviewing Previous Scan Results
Data Rescue allows you to immediately review the results of any completed scans. This is very useful in case you
have forgotten to recover some files from the first attempt, or if you have to take a break from the recovery process. By
default, Data Rescue will only save the last scan result. If you want to work with and manage multiple scan results, you
must enable expert mode.

To review any previous scan results:

1. Make sure expert mode is enabled
2. Click on View in the toolbar and select Scan Results.
3. If more than one scan was completed, select the completed scan from the list to load the results of the

previous scan.

If the previous scan you wish to view is not visible, click and drag the little gray button in the middle of the left window
area to the right until you can see the previous scan. Once the scan results have been reloaded, you may resume
recovering data from reloaded results.
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8 Drive Failure Detection
Data Rescue can detect when a drive may be failing by analyzing the time it takes to read from the drive. If at any time
it detects this, the Drive Failure Warning window will appear.

At this point Data Rescue has detected slow read access on one or more of your drives, which may be a sign of a
failing drive. If this persists, you have a few options:

1. Stop the current task (scan, recovery, etc.) and perform a Clone. Cloning allows you to copy your drive to good
drive. Data Rescue can then scan and recover off the good drive safely.

2. Disconnect the drive from your computer, turn off its power (if applicable), and contact a data recovery
company.

3. Let the current task continue until completion (not recommended).

Warning: Attempts to run a scan on your drive (if it is failing) for an extended period of time (e.g. days)
may cause the drive to completely fail. This could prevent any data recovery company from being able
to recover your data entirely.

Selecting a drive and clicking Ignore will cause Data Rescue to ignore all further warnings on that drive until the
application is relaunched.

Selecting Details will provide a list of the sector (block) offsets and the time it took for Data Rescue to read from that
sector. This is more useful for expert users such as data recovery technicians.

For further assistance with a possibly failing drive, please see the Drives With Suspected Hardware Problems section.
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9 Preferences
The Preferences menu is available under the Data Rescue 4 menu bar at the top of the screen.

9.1 General
Enable expert features  will display a fourth section in the Preferences menu titled Expert. It will enable a variety of
additional features to help recover from advanced data recovery scenarios. The expert features are designed for
technicians or experienced computer users. See Expert Features for more information about expert features.

Automatically check for updates  will detect whether there are any new versions of the software available for
download. This setting is enabled by default and will only check for updates if an internet connection is available.

Scan Complete Sound and Recovery Complete Sound allows you to specify a specific sound to play when the scan
or recovery has finished.

Reset Warnings will reset all warning dialogs in Data Rescue where you can prevent the warnings from being
displayed. For example, when quitting Data Rescue there is a confirmation dialog that shows which can be disabled
from showing again. When you reset all warnings, that dialog will appear again.

9.2 Preview
The Preview preferences include settings for Data Rescue’s preview feature while viewing found files.

Show Preview above other windows  will keep the Preview window displayed at all times and prevent the window
from being hidden by other program windows.

Make Preview opaque will remove the translucent effect from the Preview window when enabled.

Auto-play audio and video files  will immediately play any audio and video files when the preview window is opened
for an audio or video file type.

Maximum auto-preview file size  allows you to set the maximum size of a file that will be previewed automatically. By
default it is 10MB, so any file greater than this will not generate a preview until one is manually requested.

Switch to Data view when Preview is not available  requires Expert Mode to be enabled in General preferences.
Enabling this setting will display the raw data for unrecognized file types in the Preview window.

9.3 Scan Engine
The Scan Engine preferences are additional settings for adjusting Data Rescue’s scan processes. Although there are
many additional settings available, the default values should be fine for most situations and users, so changing these
settings should not be necessary. The Scan Engine preferences are available to provide extra flexibility for expert users
and in unusual circumstances where the default settings are not providing substantial results.

The Scan Engine preferences are organized hierarchically and displayed as a tree. Highlighting a portion of the tree in
the left-hand window will cause any associated properties and values to appear in the right-hand window. If you
highlight a property, a description is displayed in the small text window in the lower-right corner of the window.
Properties with boolean (on/off) values are represented with a checkbox. Properties with numerical or text values are
shown with a text field that can change the value. If a property is not editable, it will be shown in a gray font (dimmed).
To edit a numerical or text value, double-click the current value, then type in the new value.

For properties which represent file sizes, you can input a new value using KB, MB, or GB size shortcuts. For example,
to specify a size of 2 kilobytes, you can input either “2048” or “2KB”.

The most common need to access the Scan Engine preferences is to increase the maximum file size for a certain file
type when you expect to find very large files of this type. For example, the default maximum size for most movie file
types is 10GB. If you are looking for 25GB Quicktime movies, you will need to go into the preferences and increase the
maximum file size to something larger than the biggest file you are looking for.

Reset Scan Engine Preferences will changes all the Scan Engine Preferences back to default settings. This is useful
if you have previously changed any of the Scan Engine Preferences and would like to run based on the default
configurations.

The various scan engine preferences are discussed in the following sections.

9.3.1 Cloning Preferences

The Cloning Preferences are for advanced users who have special needs with regards to cloning. The default cloning
strategy should be adequate for almost all users and situations.



Data Rescue supports the following cloning strategies to help you accomplish this, which are described below starting
with the simplest approach.

Straight Copy - This straightforward strategy starts at the beginning of the source media, and sequentially copies
buffers of information to the destination media, one at a time, working straight through from start to end. If read errors
are encountered, the algorithm just keeps going through them sequentially. If the disk should happen to have an area
of errors close to the start of the hard drive, this means the algorithm may spend many hours trying to work through
this area, without having copied much data.

Reverse Copy - This strategy is nearly the same as the straight copy, except that instead of working from the start of
the media to the end, it works from the end of the media to the start. In the aforementioned case where there were
errors at the beginning of the media, this strategy can help by allowing most of the data to be cloned before running
into the problem area.

Bisect Copy - This strategy is influenced by the detection of errors found during the clone process. The clone will start
at the beginning and clone until an error is encountered. Once an error is detected, the remaining space to clone is
divided in half, then the clone process will continue from the second half of the remaining space. After the second half
is cloned, the clone will return to the first half of the space to finish cloning. This process will repeat as more errors are
detected on the hard drive.

Segment Copy - This is the default cloning strategy that is similar to bisect copy, but provides a more elaborate and
efficient method to clone the media. The space of the hard drive is divided into 64 pieces, which are further subdivided
if errors occur to ensure a clone of the healthy blocks of data while ignoring any bad blocks. If there are no errors, it will
proceed exactly like the straight copy from the start to the end.

Most users should just use the default segment copy. The Reverse Copy method can be useful if the user knows that
most of the errors are near the start of the media.

9.3.2 File Modules

The reconstructed files that are found by Deleted Files Scan or Deep Scan are based on individual file modules. Each
file module is responsible for detecting one kind of file. Most file modules have a number of preference properties in
common, such as enable, maximum file size, etc. The file modules are grouped by category based on the file type. For
convenience, some of the properties for the individual file modules may be specified at the category level of the tree,
which will allow all the file modules of the same category to use the same values. Individual file modules may still
override the values from the category values.

9.3.2.1 Top Level File Modules Preferences

Enabled specifies whether a module is enabled to look for files during a scan. The default enabled value for this node
is On. All the file modules underneath this point of the tree will be enabled, unless overridden at a lower level.

Number of filename digits  controls how many numerical digits are used when generating names for files found by the
file modules. For example, with the default setting of 5, the filenames will be generated as abc-00001, abc-00002, etc.
Changing this setting to a value of 3 will generate file names as abc-001, abc-002, etc. The purpose of the leading
zeros is so the Finder will list these in numerical order. Setting this value to 0 will have no leading zeroes added to the
file name.

Maximum file size  controls the maximum size that certain files can be. If a found file exceeds this value, the file will be
ignored. Not all file modules implement a maximum file size.

9.3.2.2 Category Level Preferences

The category level preferences consist of the categories of file modules, such as Mail, Documents, Audio, etc. These
categories are organized the same as the reconstructed file results. The preferences that are inherited from the top-
level file modules preferences are still shown so you can see their values, but are not editable (dimmed).

A few categories have their own properties. For example, the Text category is disabled by default because its severe
impact on performance and results. However, you may choose to enable the Text category if you want to scan for a
particularly important text document that is not recovered by any other file module.

Other examples of unique preferences include Maximum consec bad chars  for Text file modules to help detect the
end of a file properly and Minimum image dimensions  for Video and Images.

9.3.2.3 File Module Preferences

The lowest subcategory displays preferences for the individual file modules. The properties which are listed in green
are preferences which are using a value from a higher place in the tree.

9.4 Recovery Preferences
Bad file color  will add a label color of your choice to any files detected by Data Rescue that were potentially recovered
as bad. The color label helps organize files when viewing them through the Finder. These bad files may be attributed
to incomplete file patterns or incorrect allocation block layouts.
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Change ownership will change the file and folder ownership for all recovered files to the user running Data Rescue.
This is helpful if the original hard drive was experiencing file ownership problems.

Clear lock will force change any lock bits when recovering files or folders when this preference is enabled. This will
allow any files or folders that were originally locked on the problem drive to be accessed, renamed, or deleted by the
user.

Copy buffer size preference specifies the size of the buffer to use for copy operations, such as recovering files. A
larger buffer size will improve the speed of the recovery of files, but will use more memory.

Make items visible will change any invisible files to be visible when they are recovered.

Omit empty files will ignore displaying any files that are indicated to have no data when enabled.

Permissions promotion will change permissions of any recovered files to “Read and Write” based on the selected
preference.

None will not change any permissions on any recovered files.
For items with no access  will change permissions only for any files set as “No Access”.
For all items will change permissions of any recovered files.

9.5 Scanning Preferences
Keep bad files will keep all found files to be displayed in the scan results, even if they appear to have bad contents or
format.

Maximum files/folders preference is used during scanning when Data Rescue has to create its own folders using
catalog files, such as the Orphans Folder within the Found Files results. When the number of files would exceed the
value set in this preference, Data Rescue will create a new folder. The default is 1000 files per folder.
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10 Expert Features
The expert features are designed for technicians or experienced computer users to help recover data in more complex
recovery scenarios. Enabling expert features from the Preferences will display two new available options: an Expert
tab within Preferences and an Expert drop-down menu in the tool bar.

10.1 Expert Preferences
Manage File Module Definition Files will list any file modules added into Data Rescue by FileIQ and allows you to
enable, import or remove file modules. This tab is primarily used to import customized file modules passed from
technical support in special case scenarios.

Manage Conflicting File Modules will list any file modules that have file patterns in common. Some file types may be
mistaken for use with another program or another version of the program. Clicking on a listed file module will display
any other file modules that were detected to have a similar file pattern. You may select a different file module to replace
the current active file module to help ensure the file is found properly by Data Rescue.

Show Welcome screen at launch  will always show the Welcome screen when Data Rescue starts up. Disable the
checkbox if you prefer to not have this displayed and instead go directly to the Select Drive/Volume step.

The When quitting section has two drop down menus to note the default behavior of Data Rescue when exiting the
application.

The first drop-down menu selects what to do with the scan results when quitting:

Keep Scans - will leave scan results. This is the default selection.
Delete Completed Scans - will delete previous scan results. This is can be selected if you are not concerned
about your previous results, and want to free the disk space.
Show Manage Scans - will display the Manage Scans window before quitting the program.

The second drop-down menu selects what to do with marked files from the Scan Results when quitting:

Unmark marked files - will unmark any files that were selected for recovery.
Leave marked files marked - will leave the marked files selected for recovery when loading those scan results.

10.2 Expert Menu
The Expert menu is available on the menubar at the top of the screen.

10.2.1 Allocation Blocks Layout

Allocation Blocks Layout  can be used after a Deep scan if the files listed by the Found Files results are not opening
properly after recovery. If none of the files open when they are first recovered, selecting this feature will provide you
with additional options which may correct the way the files are found.

During its scan, Data Rescue determines some possibilities for the proper Allocation Block Layout setup. The Block
Size is the number of bytes of the allocation block. The Offset is the number of bytes (represented in hexadecimal),
from the start of the media to the start of the file system.

The first choice is the default selection that Data Rescue considered to provide the best results, but if the files are not
recovered properly, try each of the other selections.

To find the best allocation block layout for recovering files:

1. Complete a Deep scan on the hard drive.
2. At the results window, select a basic file (such as a JPEG image or text document) from the Found Files

folder.
3. Click on Preview to view the file.
4. If the file preview does not properly show the file, go to the Expert menu and click on Allocation Block

Layout.
5. Click on the next available selection inside the Allocation Block Layout window.
6. Click on the results window.
7. Select the same file and click on Preview to view the file. If the file opens correctly, try previewing a few



other files to ensure they are viewed properly also. If multiple files begin opening correctly, this is a good
indication the right Allocation Block Layout was selected. The files can be selected and recovered at this
point.

8. If the files do not open in the Preview window, repeat steps 5 through 7 until the file is opened properly
in Preview.

In some cases, such as a drive you scanned had more than one partition or if there are remnants of older file systems
still present on the disk, you will find that some files require one Allocation Block Layout selection and other files will
require a different selection.

10.2.2 Choose Drive/Volume for Scan

Choose Drive/Volume for Scan  allows you to reselect the source hard drive or volume for any previous scan results
in case the original hard drive or volume was renamed or detected incorrectly. Selecting this feature will provide you
with a list of connected hard drives or volumes to reference as the source.

If the correct hard drive is already detected, it will be listed by itself in the window. However, if more than one volume is
displayed, Data Rescue will compare the scan results to the selected media to detect the correct scanned media. A
description below the list will state any potential issues if the wrong media is selected. The selected media which
shows the least number of mismatched checksums and does not display any significant errors will be the ideal original
source media.

Enable Show all drives and volumes  to select any drive or volume, overriding Data Rescue’s filtered list based on
the original drive/volume.

To reselect the drive/volume for scan:

1. At “Step 3: Find and Select Files”, highlight the scan results you want to reload.
2. Select Choose Drive/Volume for Scan .
3. Select the drive/volume that closely represents the original media scanned. Ensure the description has

the least number of mismatched checksums.
4. Click OK.

Once the correct media is selected, you may continue with your recovery process from the results.

10.2.3 Show Details

Show Details  gives a simple count of the number of potential file starting points found during a scan, organized by file
type. The potential file starting points are not yet validated, so the ultimate number of files found by the end of the
process will be less (sometimes dramatically less) than the number shown in the details window during the scan. The
purpose of this window is to give the user an estimate of what kinds of files are being found during the scan.

10.2.4 Block Level Tools

Data Rescue features block-level tools to display raw disk blocks. Most users will not need this feature, but advanced
users can use the block level tools to view absolute drive locations, such as viewing the partition table at the beginning
of a drive or viewing the data at the start of a file.

To display a file’s block data:

1. Highlight a file in the results window.
2. Select New Window with this File’s Data/RSRC .

The Logical block read depends on the allocation blocks layout. If the displayed data appears incorrect, try a different
allocation block layout. The Allocation Block Layout window automatically updates any open block display windows, so
you can immediately see the effect of choosing a different Allocation Block Layout.

The standard block window shows only the start of the file that was highlighted when you open it. You can open a
special “inspector” version of the block window by holding down the Option key while selecting New Window with this
File’s Data. When opened in this way, the block display window will show the all block information for the selected file.
This allows you to quickly look at the the different blocks of data for the file. If the displayed data appears incorrect, try
one of the other Allocation Block Layout choices as described in the previous section.



New Window with Block #  will display data at a specific block number on the hard drive.

To display a block number’s data:

1. Select New Window with Block # .
2. Enter the block number to view.
3. A window will appear with the block’s data. Click on Next or Previous to proceed viewing the next

block’s data.

10.2.5 Set Drive/Volume Parameters

Set Drive/Volume Parameters is a feature that allows you to specify a starting and ending location and file system
type for scanning. Using this feature manually sets parameters for the selected media. This is helpful if a hard drive’s
partition table was erased or damaged, but the file system and block size are known to simulate the original partition.

Manually setting the hard drive / volume parameters requires technical knowledge of the media’s original settings to
effectively utilize this feature.

There are several parameters that must be entered and selected:

Scan Start Block / Byte #  is the first column of values that specifies the start point of the media where Data
Rescue will begin its process. You may enter a value into either the Block # or Byte # field, which will then
automatically fill in the other field with its respective value.
Scan End / Length  allows you to choose whether you are scanning to a specific address (End), or to scan a
specific number of blocks/bytes (Length). Choose End if you know the ending address of the specific partition.
Choose Length if you know the size of the partition.
Scan End Block / Byte #  is the second column of values that specifies the ending address or length of scan
depending on what selection you have made from the drop down menu. You may adjust the value in either the
Block # or Byte # field, which will then automatically fill in the other field with its respective value.
Display format allows you to choose the displaying values for the block and byte files to Hexadecimal or
Decimal format.

The Revert Button will reset the values to the default information based on the media’s original settings.

To manually set the drive / volume parameters:

1. At “Step 1: Select Drive or Volume”, highlight the hard drive or volume for which you want to change the
parameters.

2. Select Set Drive/Volume Parameters.
3. Enter the Start Scan Block / Byte # .
4. Select End or Length from the drop down menu.
5. Enter the Scan End Block / Byte # .
6. Click on Set to apply the settings.

Once the parameters have been set, you may proceed with the standard steps to scan your hard drive.

10.2.6 Add RAID Set

Add RAID Set allows you to simulate a RAID configuration based on the RAID functionality built into Mac OS X. This is
helpful in case an Apple RAID configuration fails to mount or be recognized as a single volume. Please note that Add
RAID Set does not attempt to fix or repair a RAID set. Instead, the RAID set is configured through Data Rescue for the
purpose of scanning for data.

Add RAID Set will not write any data to the hard drive, keeping the original state of the hard drives. This feature is
specifically intended to help simulate Apple software RAID configurations. Data Rescue attempts to setup the RAID
settings based on what it detects on the drives, so it may not be necessary to alter any settings when adding a RAID
set.
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To add a RAID set:

1. At “Step 1: Select Drive or Volume”, hold the command key while clicking on the hard drives in the list
that are associated with the RAID volume. This will highlight multiple hard drives.

2. Select Add RAID Set. This selection will be active only if two or more hard drives are highlighted.
3. In the Add RAID Set list, drag the items in the list to rearrange the order of the hard drives / volumes

from first to last. Data Rescue will automatically configure the order of the drives, and set the stripe size
and RAID type according to what it sees on the drives. Only manually change the order, RAID type and
stripe size if you know them to be incorrect, or have tried a scan with them using Data Rescue’s
determined configuration and it didn’t work.

4. Select the RAID type and RAID Stripe Size. If you are not using a Striped RAID, leave the Stripe Size as
32KB.

5. Click on Continue to add the RAID set.
6. A new selection in the Source list will appear as “RAID SET”.

Once the RAID set has been added, it can be selected to scan for data. In some cases, data may not be opened
properly when recovered if the hard drives are not arranged in the correct order.

If data is not being recovered properly from the RAID, we suggest the following steps to troubleshoot the issue:

Adjust the allocation block layout and reattempt the recovery until all options are exhausted or files are
recovered.
Redefine the RAID Set by using Add RAID Set, and drag to rearrange the order of the hard drives / volumes.
Data Rescue does not currently support editing an existing RAID set. To change the configuration, you must
define a new RAID Set using the different parameters.

Data Rescue supports 3 basic types of RAID, described very briefly below.

Stripe - This is also known as RAID-0. As data is read sequentially from the RAID set, it comes first from the first
component drive until a stripe-sized amount has been read, then the next data comes from the second component
drive, and so on, in round-robin fashion.

Mirror - This is also known as RAID-1. With this scheme, each of the drives is suppose to contain the exact same copy
of data. This means that if you have an undamaged component drive, you should be able to just scan that to find your
files (you will not need to create a RAID set).

Concatenated - This is not an official RAID level, but rather a way to make multiple hard drives appear as one big
drive by concatenating them together. As data is read sequentially from the RAID set, it comes first from the first
component drive, until the end of that drive is reached, then continues coming from the second component drive, and
so on until the end of the last component drive.

The ordering of the component drives is mainly important for stripe and concatenated types. If this is wrong, the scan
may find few or no good files. To alter the order, simply drag each drive in the list into its proper position.

This RAID Stripe Size  relevant for the Stripe RAID type, but irrelevant for the other types. The default and most
common value is 32KB.

10.2.7 Erase Drive/Volume

Erase Drive/Volume allows you to easily erase the selected drive or volume. This will only reformat the disk, not erase
the contents of the disk. Drives are formatted as HFS+. If a volume is selected, only that volume will be reformatted.
Otherwise, the entire drive is reformatted and all existing volumes will be lost.
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11 Frequently Asked Questions
The following chapter contains some commonly asked troubleshooting questions and their solutions or workarounds. If
problems still persist, contact Prosoft Engineering technical support.

Data Rescue seems to freeze. What should I do?
Most cases of apparent freezing are actually slow reads due to disk problems. If Data Rescue runs into a disk area
where the disk is having trouble reading, it may appear to freeze, but actually just be very slow. If you think it has
frozen, make a note of what is being displayed on the progress display, for example, the block number, then check
again in half an hour or so and see if it has advanced at all. If it progresses, it is probably just slow due to disk read
problems. If you continue having difficulties, make sure cables connecting to the disk drives are properly seated and
consider disconnecting or turning off any unnecessary devices connected to the computer.

Why doesn’t my drive or volume show up?
If you have attached a drive with a damaged volume since you started Data Rescue, Data Rescue may not
automatically notice it. Try the File > Refresh Drives List menu item. If the volume you are looking for still does not
appear, it may be because Data Rescue is unable to find the correct name for it, in which case it may show some other
name such as “unknown” for the volume name. Or it may be that Data Rescue can see the device, but is not able to
recognize a volume structure on the device. If that is the case, you will need to choose the device name for scanning
rather than the volume.

Finally, it could be possible that your drive is malfunctioning to the point where your computer is not able to talk to it at
all, in which case even the device name will not appear. In this case, Data Rescue will not be able to scan your device.
In this latter case, you might try some or all of the following things to see if your device can be made to appear: Double-
check the drive cables and power source; remove/reattach the drive and/or power cycle it; power down and restart your
computer. You can also double check that the problem isn’t with the Data Rescue software itself by looking for your
volume/drive using Apple’s Disk Utility. If Disk Utility can see it, Data Rescue should be able to also; if Disk Utility can’t,
then Data Rescue won’t be able to either.

Why are some files listed twice?
Sometimes, your volume contains obsolete catalog entries. If Data Rescue finds two catalog entries with identical
names, it first checks if the two entries refer to the same data. If so, then the items are called “true duplicates”, and only
one of these will be retained, and the other automatically removed. If the two entries refer to different data, both of them
are retained, even if they have identical names and appear to be in the same directory, because there is no way to
know which one is the correct one. To find which is the correct entry, check dates and file contents.

Why do my found files total more than the size of the original drive?
There could be a few reasons for this, as explained below.

When you do a Deep scan, Data Rescue uses two different algorithms to locate files. These methods will often locate
many of the same files twice - once under the Found Files folder and again under the Reconstructed Files folder. (Data
Rescue does not currently have the capability to automatically cross correlate these sets of files, but may do so in a
future version.) So if you elect to recover everything, it will often be the case that the total space required exceeds the
original media size.

The second reason why the found files may total more than expected is the possibility of anomalously (and incorrectly)
large files. In the course of scanning the media, Data Rescue will often come across bad files and catalog entries. Data
Rescue is able to filter out the vast majority of these bad entries, but not all of them. Occasionally a few of these may
show up in the recovery list with incorrect and large sizes. If you suspect this may be the case, you can easily find
these large files by searching for files greater than a certain size using the Edit > Find menu item. A useful technique to
eliminate these from the recovery is: first mark everything by clicking the checkbox for the top level folders, then search
for and uncheck the large files which appear to be bogus.

A third possible reason is if the scanned drive makes heavy use of hard linked files, such as a Time Machine backup
drive. Hard linked files are used by Time Machine to store many copies of the same file with the same content, without
duplicating the contents. The current version of Data Rescue sees and recovers such files as individual files and does
not share space among the files when recovering. For example, if there are 20 hard links to a 1MB file on the original
disk, and you recover all 20 links, the recovered files will each take 1MB, or a total of 20MB. A future version of Data
Rescue may alter this behavior. Until then, the best approach for this case is to select a single set of files to recover,
such as the latest Time Machine backup folders rather than attempting to recover everything.

Why is there a delay when I click the mark checkboxes?
After scanning a large drive, there may be hundreds of thousands or millions of files and folders to deal with. When you
click on a mark checkbox in the recovery list to mark or unmark files for recovery, especially the top-level folders, Data
Rescue has to walk recursively down through most of these items to individually mark or unmark them. The time this
takes is proportional to the number of found files.
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Does Data Rescue handle RAID volumes?
With RAID, several component drives are set up to act logically as if they were a single composite drive. If your RAID
drives or file system is in good enough shape that the system can still make them appear as a single logical drive, then
Data Rescue should be able to scan that composite drive and recover files from it.

If the situation is such that the system cannot present the component drives as a single composite drive, then the
answer depends on what kind of RAID your drives are set up to do. If the drives are set up to do mirroring (i.e. each file
is stored completely on each mirror drive), then Data Rescue should be able to a Deep scan any of these component
drives and recover files.

If the RAID is configured using Apple’s software RAID system, you may enable Expert features and use the Add RAID
Set feature to help simulate and scan the RAID. If the composite RAID device is visible without adding a RAID Set, it is
almost always better to scan that than to create a RAID Set and scan it.

I recovered files, but they won’t open. What’s wrong?
The answer to this question depends on whether you’re talking about files recovered from under the Reconstructed
Files or Found Files Folder.

Files recovered by catalog (i.e. from the Found Files folder)
It’s normal for a small percentage of recovered catalog files to be bad. But if you have checked a number of them and
none of them are good, then chances are that they were recovered with the wrong Allocation Block Layout setting. Pick
out a few files to use as test files, and go back and select a different Allocation Block Layout choice and recover a few
files. If you find an ABL setting that gives good results on those files, re-do your big recovery with that setting.

Files recovered by content (i.e. from the Reconstructed Files folder)
It’s also normal for a small percentage of these files to be bad. If the original file was fragmented (not stored on disk in
consecutive blocks), then it can not be properly recovered by content. In most normal situations, most files on a user’s
disk will not be fragmented. Typical fragmentation rates for files tend to be just a few percent. Note: The ABL setting
plays no role in recovering files under the Reconstructed Files folder.

Can I recover files that I deleted accidentally?
In OS X, when a file is deleted, for example by dragging it to the trash and emptying the trash, the file’s name and
folder information is usually erased by the system, and is therefore irretrievably lost. However in most cases, the most
important part of the file - its contents - are still present on the disk. Finding the file by its contents alone is in general a
difficult task, requiring algorithms to recognize those contents among all the billions of bytes of data on the disk. The
Deleted File scan will list over 150 major file types it detects based on its file patterns.

What are Data Rescue’s general content scan capabilities?
In generic technical terms, Data Rescue’s content scan is potentially suitable for any file type that consists of a single
fork. For files that have both a data and a resource fork, the forks may be recoverable separately by content scan, but
Data Rescue has no means to connect the two pieces back together. Some “files” are in reality a collection of separate
files which the Finder treats like a single file. This is called a “bundle”. The individual components of a bundle may be
recoverable by content scan, but again Data Rescue has no automated way to associate these components back
together into a bundle.

An additional requirement for a successful recovery by content is that the file’s data not be fragmented. In other words,
it must be stored from beginning to end in consecutive media locations. Fortunately, most files get stored on disk that
way. OS X tries to store files in a non-fragmented way when it can. Still it is typical for a small percentage of files to be
fragmented, and these will not recover properly when found by content.

Important: Do not mistakenly use a defragmentation utility (or any other program which will alter your disk) after losing
your files, and prior to scanning with Data Rescue. Doing so will only make it less likely that you will be able recover
your files.

Note: The above limitations apply only to the files found by content. For files that are found by their catalog entries, the
original bundles and forks may be properly recovered, and fragmentation is not an issue.

Specifically what types of files can Data Rescue find by content?
The actual list of file types recoverable by content can be seen from within Data Rescue by going to the Data Rescue
Preferences menu and browsing through the File Modules tree. We expect to be adding to this list on an ongoing
basis. For a recent list of filetypes recoverable by content, see the Release Notes file that came with your Data Rescue
distribution.

For any file types not supported by default, Data Rescue’s FileIQ feature will allow you to analyze sample files and
possibly generate a file module to help detect the files you are looking for.
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12 Glossary
Allocation block: this is a block of file data within the file space of a volume. The size of allocation blocks is the same
within a volume, but different volumes can have different allocation block sizes. This size is always a multiple of 512
bytes so allocation blocks boundaries are always aligned with logical blocks.

Creator type: Associated with every file on a Mac is a four letter code that specifies the file’s creator. The creator is
typically the application that created the file to begin with. This code is hidden from the user, but is used by the file
system in a number of ways. For one, along with the File type, it helps determine the icon to display for that file. In
addition, when you double click on a document, it is the application that has the same creator code as the document
that will be launched to open that document.

File type: Associated with every file on a Mac is a four letter code that specifies the type of file it is (e.g. ‘TEXT’
denotes a text file, ‘APPL’ denotes an application). On many other operating systems, the file type is part of the name;
it is usually a three-letter code following a period (e.g. myfile.txt or letter.doc). On the Mac, this code is hidden from the
user but serves the same purpose: to identify the kind of file. It uses the file type, along with the Creator type (see
below) to determine the icon to display for a given file.

HFS, HFS+ : This stands for “Hierarchical File System” and “Hierarchical File System - Plus”. These are the names of
Apple’s proprietary File system layout for Mac OS computers. The newer, HFS+ system affords greater file and disk
capacities, as well as performance improvements over that of the older HFS architecture. HFS+ was released with
Apple’s 8.1 operating system and is designed to supersede HFS. All Mac OS versions from 8.1 Classic through OS X
10.x support both HFS and HFS+.

Orphan: An orphaned file or folder is a file or folder which Data Rescue has discovered a catalog entry for, but no
parent catalog folder can be found. Items like this are presented under the Orphans Folder in the Data Rescue
recovery window.

Physical block: this is a 512-byte block of information on a physical device. Physical blocks start at zero so physical
block #0 is usually the first block of the partition map of a physical device.

Remote volume: A remote volume is a volume that is not directly connected to your computer. Typically a remote
volume is a file server. If your Mac is not connected to a computer network (e.g. at your company), you probably don’t
have access to any remote volumes.
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13 Supported File Types
Data Rescue can support any file type, if it is able to be found in an HFS catalog. Such files will appear under the
“Found Files” folder in the recovery list. For files which have been deleted (and therefore have no HFS catalog entry),
Data Rescue supports finding files of a great many types by their content when doing a Deleted or Deep Scan. Such
files will appear under the “Reconstructed Files” folder in the recovery list. Below is a list of the file types supported for
Reconstructed Files. In addition to these, other file types not on this list may often be recoverable with the new FileIQ
feature, using user-supplied sample files to teach Data Rescue about that type.

Images:

JPEG
TIFF
PNG
GIF
Adobe Illustrator AI
EPS
RAW Camera Formats CRW, CR2, NEF, DCR, ORF, DNG, MOS, SRF, RAF, X3F, MRW
PSD
BMP
PCS
JPEG 2000
CaptureOne TIFF
Print Shop
MacDraft, MacDraw, MacPaint
PICT
InDesign
PCX
ICNS
ICO

Movies:

QuickTime
MPEG-1/MPEG-2/MPEG-4
AVI
WMV
Flash SFW
Final Cut Projects
Raw DV
Cinema 4D
After Effects
MXF
M2TS/MTS
iMovie Project

Audio:

WAV
MP3
AIFF
AAC/M4A/M4P/M4B
Ogg
Logic LSO



Finale Project
Maya Session
ProTools Session
Reason Session/Refill/Published/Recycle
Digital Speech Standard

Mail:

Eudora
AppleMail
Outlook Express
Entourage database files
Raw EML/EMLX files

Documents:

PDF
Word
PowerPoint
Excel
Quark
iWork ’05 - ’09
OpenOffice
Quicken
QuickBooks
AppleWorks/ClarisWorks
FreeHand
AutoCAD
EndNote
FinalDraft
InDesign
VectorWorks
ArchiCAD PLN and LBK
PageMaker
FileMaker
Word Perfect
Celtx Project

Text:

Generic ASCII Text TXT
RTF
XML
HTML
Postscript (non-binary)

Archives:

Retrospect
Gzip
ZIP
RAR
BZip
Stuffit
DMG and Sparse Images



Java archives

Miscellaneous:

Resource forks
Property lists (binary and XML). Includes the following subtypes, recovered in various folders and with various
extensions: Comic Life, Master Row, Soft Fill, IBCocoaFramework, ChatRoom, QCPatch, AudioTrack,
CSElement, Web archive, PmProj, Meta Model Key, User Model Key, Axis Limit, Safari bookmarks, and
MyThought files.
Keychain files
OLE files (an older Microsoft Office format, includes generic OLE, Word, PowerPoint, Excel,)
Panorama
SQLite
PEF (a binary executable format)
QuickCeph (disabled by default)
Red One (R3D) files
Pro Tools Session Files
iTunes Music Library
Doom 3 save files
Adobe GoLive
FormZ v4
Cinema 4D
FinalDraft
HyperCard
Finale
Carrera Pro 4
4D Database
iCal
Maya
Quicken
Now Up To Date
Now Contact 3
ProTools
AOL Filing Cabinet
Reunion-8
Phase One TIFF
Lotus Notes Archive
Perl
PHP
TimeCard
Logic Pro
PowerSchool Database
Print Shop
Stickies
Address Book
Virtual PC7
EndNote
MacTracv6
Reason
AIM Chat
MacInTax
TurboTax
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Mozilla Bookmarks/Address Book
StatView
Easy Grade Pro3.6
Cubase
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14 Release Notes
Version 4.3.1

Increase maximum file size
Bug fixes

Version 4.3

Added support for macOS 10.12
Added built-in chat for quick and easy live support
Improved reliability of searching by date
macOS 10.8 is now the minimum required version

Version 4.2.3

Add VoiceOver support

Version 4.2.2

Improved reliability of Create BootWell Drive
Improved compatibility with 10.11

Version 4.2.1

Add compatibility with 10.11
Fix bug where available bytes can be reduced if the recovery immediately fails
Fix some recovery errors from preventing a final completion dialog from showing
Use a built-in web browser for opening URLs when in BootWell

Version 4.2

Improved performance of SQLite module
Add serials to drives in “Add RAID Set” when available
Fix Clone not filtering out system drives

Version 4.1

By default Data Rescue now only works with one scan at a time
A BootWell button has been added to the Welcome screen
The Welcome screen buttons have been simplified and renamed
For safe recovering of the main drive, you must now use a BootWell drive
Note: expert mode can be enabled to revert most new functionality

Version 4.0.1

Fixed BootWell bugs with 10.7

Version 4.0

Added BootWell feature
Easier-to-use interface
Improved Quick Scan algorithm
Improved scan performance
Retina compatible
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15 Credits
Portions of the program use the following copyrighted material.

URLTextView by Aaron Sittig

RSVerticallyCenteredTextFieldCell by Daniel Jalkut

Sparkle by Andy Matuschak

Warning by Melissa Holterman from The Noun Project

Eye by Mister Pixel from The Noun Project
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